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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skeermen.
Tag den tid du behgver for at leese vejledningen,
inden du bruger skaermen. Den indeholder
vigtige oplysninger om bemaerkninger angdende
brugen af din skarm.

Philips garanti deekker under forudsatning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kabsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer; justeringer
eller fremgangsmader, der ikke er beskrevet i
denne dokumentation, kan resultere i elektrisk
sted, elektriske ulykker og/eller mekaniske
ulykker.

Lees og felg disse vejledninger, nar du tilslutter
og anvender din computerskarm.

Betjening

* Hold venligst skeermen vek fra direkte
sollys, meget steaerkt og lyst lys samt fra alle
varmekilder. Laengere tids udseettelse for
sadan et miljg kan resultere i misfarvning
og skade pa skeermen.

* Fjern alt, der kan risikere at falde i
ventilationsdbningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

» Bloker ikke ventilationsdbningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til strgmstikket
og stikkontakten.

*  Huvis der slukkes for skeermen ved at fjerne
stremkablet eller jeevnstremsledningen,
skal du vente 6 sekunder, for du sztter

stremkablet eller jeevnstrgmsledningen til
igen for at opna normal betjening.

* Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
strgmkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

*  Udset ikke skaermen for kraftige
vibrationer eller sted under anvendelse.

*  Sla ikke pa skeermen, og undga at tabe den
under brug eller transport.

Vedligeholdelse

*  Som en beskyttelse af skeermen skal du
undga at trykke kraftigt pa LCD skaermen.
Nar du flytter din skeerm, sa tag fat
om rammen for at |gfte den. Laft ikke
skeermen ved at sztte din hand eller fingre
pa LCD skeaermen.

* Tag stikket ud fra skeermen, hvis du ikke
skal bruge den i en leengere periode.

* Tag stikket ud at kontakten til skaermen,
hvis du skal renggre den med en let fugtet
klud. Skaermen kan tarres af med en tor
klud, nar der er slukket for stremmen.
Under alle omstaendigheder, ma der ikke
bruges organiske oplasningsmidler til
rengering af din skaerm.

» For at undga risiko for elektrisk sted eller
permanent beskadigelse af anlaegget, ma du
ikke udseette skaermen for stev, regn, vand
eller miljger med hgj fugtighed.

*  Huvis din skaam bliver vad, skal den tarres af
med en ter klud sa hurtigt som muligt.

e Hvis der kommer fremmed substans eller
vand ind i skeermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skarmen til servicecenteret.

*  Skaermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* Forat opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skeermen et sted, der



er indenfor fzlgende temperatur- og
fugtighedsomrade.

¢ Temperatur: 0-40°C 32-95°F

»  Fugtighed: 20-80 % RH

Vigtige oplysninger om fastbrandte billeder/

spogelsesbilleder.

* Serg altid for at aktivere en pauseskaerm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt. Du skal altid bruge
en pauseskeerm eller et andet program,
der opdaterer skaermen regelmassigt,
hvis skaermen viser statisk materiale
i lengere perioder. Uafbrudt visning
af et stilbillede over leengere tid, kan
fordrsage "“brandmaerker”, ogsa kendt som
“efterbilleder” eller “spegelsesbilleder” pa
skaermen.

“Breendmaeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
feenomen i LCD skaermteknologi. | de
fleste tilfeelde vil “brandmarkerne’” eller
“efterbilledet” eller “spogelsesbilledet”
forsvinde gradvist, efter skaermen er
blevet slukket.

O Advarsel

Hvis der ikke aktiveres en pauseskeerm eller
et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbreendinger’” eller
“efterladte billeder” eller "spagelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstdende skade dakkes ikke af
garantien.

Service
* Kabinettet ma kun dbnes af kvalificeret
servicepersonale.

* Hvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
“Kundeinformationscenter”)

* For oplysninger om transport, se
“Tekniske specifikationer”.

» Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

@ Bemaerk

Kontakt en servicetekniker, hvis skeermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal ggre, ndr betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.



1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemarkninger, forholdssregler og advarsler

| hele denne vejledning kan tekstafsnit veere
ledsaget af et ikon, og sta med fed eller kursiv
skrift. Disse afsnit indeholder bemarkninger og
punkter; hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som fglger:

& Bemark

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan gere bedre brug af
computersystemet.

0 Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader; og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page


http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page

2 Opsaetning af skeer'm B Installation af stander

1. Anbring skeermen med forsiden vendt
nedad pa en bled og jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

1] Emballagens indhold 2. Pasazt/skyd basesgjlen pa skeermen, indtil
den klikker pa plads.

Q 3. Hold pa skeermens stander med begge
\ hzaender, og set med en fast hand standeren

ind i fodsgjlen.

*HDMI

* Afhaenger af landet



HE Tilslutning il PC
223V5LSB/223V5LSW/223V5LSB2

PHILIPS

© AC stremindgang

© VGA-indgang

O DVI-D-indgang
(tilgeengelig pa udvalgte modeller)
Kensington anti-tyverisikring

223V5LHSB/223V5LHSW/223V5LHSB2

PHILIPS

© AC stromindgang

© VGA-indgang

© HDMl-indgang

O HDMI lydudgang
(tilgeengelig pa udvalgte modeller)

© Kensington anti-tyverisikring

Tilslutning til pc

1. Tilslut ledningen ordentligt pa bagsiden af
skaermen.

2. Sluk for computeren og tag netledningen
ud af stikket.

3. Slut skeermens signalkabel til videostikket
bag pa computeren.

4. Seet computerens og skarmens
netledninger til et stik i nerheden.

5. Teend for computeren og skaermen. Hvis
skeermen viser et billede, er installationen
gennemfert.

2.2 Brug af skaerm

El Produktbeskrivelse set forfra

223V5L:
(5]
AaUTO/v  ED/A /0/4\ (E)fOK (ll)
(7] (6 o © (2] o
@ (O |Tender og slukker for skarmen.
Sadan far du adgang til OSD-
menuen.
0 S/0K Bekreeft justering af
skaermmenuen.
Ga tilbage til det forrige OSD-
o < niveau.
O | O |usterer lysstryken.
© AV [Tiljustering i skermmenuen.
O | [ [Skifter skeermformat.
©@ | AUTO |Juster skeermen automatisk.




Bl Beskrivelse af OSD-visningen OSD-menuen
. Nedenstdende er en generel oversigt over
R ?
Hvad er OSD (On-Screen Display)? strukturen i OSD-displayet. Du kan anvende

Visning pa skarmer? [On:Screen lDiSP|aY den som opslag, ndr du senere skal orientere
(OSD)] er en funktion pd alle Philips LCD dig i de forskellige justeringer.

skeerme. Den szetter en slutbruger i stand
til at justere skaermindstillingerne, eller

vaelge skarmens funktioner direkte via et VGA _
instruktionsvindue pa skermen. Et brugervenligt [ " E DV] (avallable for selective models)
skaeermvisningsinterface vises som nedenfor:

Main menu Sub menu

HDMI (available for selective models)

223V5LHSB/223V5LHSW/223V5LHSB2: Picture Format  —— VVide Screen, 4:3
’ Brightness — 0~100

— Picture
Contrast — 0~100
SmartContrast —— On, Off
Over scan — On, Off
(available for selective models)
Vol — 0~100

— Audio E oume

Mute — On, Off

(available for selective models)

Color Temperature — 6500K, 9300K
— Color E sRGB
User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language —— English,Espafol,Francais,Deutsch,taliano,
Portugués,Pycckui, & 1 3, Tiirkge,
Nederlands, Svenska, Suomi, Polski, Ce&tina
&= 0{, BAEE, Maryar, YkpaitcbKka,
Portugués do Brazil EN\nVIKY| (TpoaIpeTIKAq),
R S (AT E)
— Horizontal — 0~100
223V5LSB/223V5LSW/223V5LSB2 —OsDSewngs [ 1 o
[ Transparency — Off,1,2,3,4
(pa model 1A): L — OSD Time Out ~ — 5s, 105, 20, 30s, 60s
BieE — Auto
L e — H. Position — 0~100
of — V. Position — 0~100
[ Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
L Information

Grundleggende og enkle anvisninger til
kontrolknapperne

| skeermmenuen ovenfor; kan du bruge

VY A knapperne foran pa skeermen til at flytte
markeren med, og tryk pa OK knappen, til at
bekrafte dit valg eller &ndring.



E Meddelelse om oplesning

Denne skarm er fremstillet til optimal ydelse
pa dens native oplgsning, som er 1920 x 1080
@ 60 Hz. Nar skeermen bruger en anden
opl@sning, ses falgende advarsel pa skeermen:
Brug 1920 x 1080 @ 60 Hz for at opna det
bedste resultat.

Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i
OSD (skaermmenuen).

a Fysisk funktion
Vip

2.3 Fjern standeren og foden

[1] Fiernelse af foden

Inden du begynder at adskille skeermens fod,
skal du felge vejledningerne nedenfor for at
undga mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jaevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2. Tryk pa laseklemmerne for at fierne foden
fra sgjlen.




© Bemarkning
Denne skaerm accepterer et 100 x 100 mm
VESA-kompliant monteringsinterface.

PRIUPS

109mm

100mm




3. Billedoptimering

3.1 SmartContrast

Bl Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skaermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
deemper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pd en merk
baggrund.

El Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, s det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, leesbar tekst ved kontorarbejde.Ved at
nedsztte skeermens stremforbrug, sparer du
energiomkostninger og forlenger skaeermens
levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og
baggrundslysets intensitet indstilles. Denne
funktion forbedrer den dynamiske kontrast og
giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.2 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skaermen
via et nemt, grafisk interface. Komplicerede
justeringer hegrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af oplegsning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er

udstyret med den seneste teknologi i algoritmer

for hurtig behandling og reaktion, og er tilmed

Windows kompatibel, og klar til at forbedre din
oplevelse med Philips-skeermel!

El installation

* Felg instruktionen og fuldfer installationen.
¢ Du kan starte, nar installationen er fuldfart.
*  Hvis du vil begynde senere, kan du klikke

pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

Opstartsguide

» Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet fgrste gang.

*  Guiden leder dig trin for trin gennem
indstillingen af skaermen.

*  Du kan ogsa ga til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.

* | Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.



Bl Start med Standard-vinduet:

Adjust menu (Indstillingsmenu):

*  Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),
Contrast (Kontrast), Focus (Fokus), Position
(Position) og Resolution (Oplasning).

* Udfer indstillingen ved at folge
instruktionerne.

* Installationen kan annulleres med Cancel
(Annuller).

11



Color menu (Farvemenu):

*  Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration
(farvekalibrering).

* Udfer indstillingen ved at folge
instruktionerne.

* Se nedenstaende oversigt med
undermenupunkter baseret pa din
indtastning.

*  Eksempel pa Color Calibration
(farvekalibrering):

12



1. “Show Me" (Vis Mig) starter vejledningen til
farvekalibrering.

2. Start — starter en 6-trins
farvekalibreringssekvens.

3. Quick View (Hurtigvisning) indleeser far/
efter-billederne.

4. For at vende tilbage til Color (Farve)
vinduet, skal du klikke pa Cancel (Annuller).

5. Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfere en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

6. Der skal veere patentoplysninger pa
kalibreringsskarmen.

Forste farvekalibreringsskaerm:

* Previous (Foregaende) knappen er
deaktiveret, indtil du gér videre til den
anden farveskaerm.

*  Next (Naste) gar til efterfelgende mal
(seks mal).

»  Ga til sidst til File > Presets (File > Forvalg)
vinduet.

*  Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden.
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Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, nar Preferences
(Indstillinger) er valgt i Preferences (Funktioner)-
rullemenuen. Pd en ikke-understgttet skaerm
med DDC/CI er kun Help (Hjzelp) og Options
(Funktioner) til radighed.

* Viser nuveerende, foretrukne indstillinger.

* Funktionen aktiveres ved at afmaerke feltet.
Afmarkningsfeltet er en flip-flop.

* Enable Context Menu (Aktivér Indhold
menuen) er som standard afmarket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) viser
valgmulighederne i SmartControl Lite
pa Select Preset (Valg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen
ved at hgjreklikke pa skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

* Enable Task Tray (Aktiver Jobbakke)
menuen er som standard afmaerket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) ger, at
systembakkens ikon til SmartControl Lite
vises. Et hgjreklik pa jobbakke-ikonen
viser menufunktionerne for Help (Hjelp),
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).



* Run at Startup (Ker ved opstart) er
som standard afmaerket (Til). Nar den
er deaktiveret, starter SmartControl Lite
ikke ved opstart og ikonet vises ikke i
systembakken. SmartControl Lite kan
kun startes fra genvejen pa skrivebordet
eller fra programfilen. Intet forvalg, som er
indstillet til at kere ved opstart, indleses
nar denne boks ikke er afmarket (er
deaktiveret).

* Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows
7/8,Vista, XP). Standard er 0%
uigennemsigtighed.

Options > Input (Funktioner > Indgang)

- er kun aktiv, nar Input (Indgang) er valgt i
Options (Funktioner) rullemenuen. Pa en ikke-
understgttet skeerm med DDC/CI er kun Help
(Hjeelp) og Options (Funktioner) til radighed.

Alle andre faneblade i SmartControl Lite er ikke

til radighed.

* Vis Source (Kilde) instruktionsvinduet og
nuvaerende indgangskildeindstillinger.

* P4 enkeltindgangsskeerme ses dette vindue
ikke.

14

Options > Audio (Funktioner > Lyd) - er
kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pa en ikke-understettet skeerm med DDC/CI
er kun Help (Hjzelp) og Options (Funktioner) til
radighed.

Help > User Manual (Hjelp >
Brugervejledning) - er kun aktiv, nar User
Manual (Brugervejledning) er valgt i Help
(Hjeelp) rullemenuen. Pa en ikke-understottet
skeerm med DDC/CI er kun Help (Hjeelp) og
Options (Funktioner) til radighed.



Help > Version (Hjlp > Version) - er kun aktiy,
narVersion (Version) er valgt i Help (Hjeelp)
rullemenuen. Pd en ikke-understgttet skaerm
med DDC/Cl er kun Help (Hjzlp) og Options
(Funktioner) til radighed.

Context Sensitive (Indholdssensitiv) menuen

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmeerket
i Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

”Context” (Indhold) menuen har tre punkter:

*  SmartControl Lite - nar valgt, ses About
(Om) skaermen.

*  Select Preset (Valg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

* Tune Display (Indstil Skaerm) - abner
kontrolpanelet til SmartControl Lite.

Task Tray (Jobbakke) menu aktiveret
Menuen i systembakken kan ses ved at
hgjreklikke pa SmartControl Lite-ikonet
i systembakken. Et venstreklik starter
programmet.

Jobbakken har fem punkter:

*  Help (Hjalp) - adgang til
brugervejledningsfilen: Abner User Manual
(Brugervejledningen) med standard
browservinduet.

* Technical Support (Teknisk Support) - viser
siden med teknisk support.

*  Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

* About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

*  Exit (Afslut) - Luk SmartControl Lite.

Huvis du vil kere SmartControl Lite igen,

skal du enten veelge SmartControl Lite i

programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

PHILIPS



Task Tray (Jobbakke) menu deaktiveret
NarTask Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).

@ Bemaerk

Alle billederne i dette afsnit er kun til reference.
Softwareversionen til SmartControl kan a&ndres
uden varsel. Se venligst altid pa den officielle
Portrait webside www.portrait.com/dtune/
phl/enu/index for at downloade den seneste
version af SmartControl softwaret.

16



4. Tekniske specifikationer

Billede/Skarm

Skeermpaneltype TFI-LCD

Baggrundslys LED

Panelstarrelse 21.5" W (54,6cm)
Billedforhold 169

Pixel pitch 0,248 x 0,248 mm
Lysstyrke 250 cd/m? or 200 cd/m?
Smart-kontrast 10,000,000:1
Kontrastforhold (norm.) 1000:1 or 600:1 for 200 nits
Reaktionstid (norm.) 5ms

Optimal oplgsning

1920 x 1080 pa 60 Hz

170° (H) / 160° (V) ved C/R > 10

Tilslutningsmuligheder

Synsvinkel or 90° (H) / 65° (V) ved C/R > 10 for 200 nits
Skeermfarver 16,7 M

Vertikal opdateringshastighed 56Hz - 76Hz

Horisontal frekvens 30kHz - 83kHz

sRGB JA

223V5LSB/223V5LSW/223V5L5B2: VGA (Analog),DVI
(digital HDCP) (valgfri)

Inputsignal 223V5LHSB/223V5LHSW/223V5LHSB2:VGA (Analog) HDMI
(digital HDCP)
Audio In/Out HDMI lydudgang(223V5LHSB/223V5LHSW)
Inputsignal Separat synk., synk. pa gren
Brugerfunktioner AUTO/Y  [D/A 0-/4 /0K 0)
Engelsk, Tysk, Spansk, Fransk, Italiensk, Ungarsk, Hollandsk,
GED gies Portugisisk, Brasiliansk portugisisk, Polsk, Russisk, Svensk, Finsk,

Tyrkisk, Tjekkisk, Ukrainsk, Simplificeret kinesisk, Japansk, Koreansk,
Greesk(valgfri), Traditionel kinesisk(valgfri)

Andre funktioner

Kensington-Ias

"Plug & Play" kompatibilitet

DDC/CI, sRGB, Windows 7/Windows 8/Vista/XP Mac OSX,
Linux

VESA montering

Vip

100x100 mm

-5/+20

223V5LHSB/223V5LHSW/223V5LHSB2:

Strgm

Tendt-tilstand

19.66 W (typ.), 23.76 W (max.)for 223V5LHSB/223V5LHSW
or 21.63W (typ.), 25.63W(max.)for 223V5LHSB2

| dvale (Standby)

0,5W
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Fra

0,5W

Stremdiode

Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz

223V5LSB/223V5LSW/223V5LSB2:

Stregm

Tendt-tilstand

18,6W (typ.), 22,57W (maks.) for 223V5LSB/ 223V5LSW
or 17,07W (typ.), 20,26 W (maks.) for 223V5LSB2

| dvale (Standby)

0,5W

Fra

0,5W

Stremdiode

Til-tilstand: Hvid, Standby-/Sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz

Mal
Produkt uden fod (B x H x D)

503 x 376 x 213 mm

Produkt uden fod (B x H x D)
Vagt
Produkt med fod

503 x 316 x 50 mm

2,605kg

Produkt uden fod

2,304kg

Driftsforhold

Temperaturomrade (drift) 0°C til 40°C
Temperaturomrade (ikke i drift) | -20°C til 60°C

Relativ fugtighed 20% til 80%

MTBF 30.000 timer

ROHS JA

EPEAT Silver (www.epeat.net)
Emballage 100 % genbrugelig

Energy Star
Overholdelse og standarder

Myndighedernes godkendelser

A

CE Mark, FCC Class B, EAC, SEMKO, BSMI, cETLus,
1S09241-307, TCO Certified , INMETRO(Only for selective models)

Farve Sort/Hvid,
Overflade Tekstur
& Bemark
1. EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besag venligst www.epeat.net
for registreringsstatus i dit land.
2. Disse data kan &ndres uden varsel. Ga til www.philips.com/support for at hente den seneste

version af brochuren.



www.epeat.net
www.philips.com/support

4.1 Oplesning og forudindstillede
funktioner

El Maksimal oplesning
1920 x 1080 ved 60 Hz (analogt indgang)
1920 x 1080 ved 60 Hz (digital indgang)
B Anbefalet oplesning
1920 x 1080 ved 60 Hz (digital indgang)

V frekv. Oplgsning L frekv. (Hz)
(kHzx)
3147 720 x 400 70,09
3147 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
63,89 1280 x 1024 60,02
79,98 1280 x 1024 7503
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
6529 1680 x 1050 59,95
67,50 1920 x 1080 60,00

& Bemark

Bemaerk venligst at din skaerm virker bedst med
native oplgsning pa 1920 x 1080 ved 60Hz. For
at opna den bedste skeermkvalitet, bedes du
venligst bruge denne opl@sning.
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5. Stremstyring

Hvis der er installeret et skeermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skaermen automatisk
nedsatte stremforbruget, nar den ikke bruges.
Nar input fra tastatur; mus eller anden input-
enhed registreres, "vagner" skeermen automatisk
igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug
og signalering:

223V5LHSB/223V5LHSW/223V5LHSB2:

Energispare-definition

VESA )
tilstand Video | V synk | L synk | Opbrugt strem | LED Farve
19.66 W (typ)
for 223V5LHSB
Aktiv TIL Ja Ja 223V5LHSW Hvid
or 21.63W (typ)
for 223V5LHSB2
| dvale . . Hvid
(tandbyy | TRA | Nei [ Nej | 0SWyp) | iy
Kontakt Fra| FRA - - 0.5W (typ.) FRA

223V5LSB/223V5LSW/223V5LSB2:

Energispare-definition

VESA "
distang | Video [ Visynk | Lsynk | Opbrugt strom | LED Farve
18,6W (typ.) for
223V5LSB
Aktiv TL | Ja Ja / 223V5LSW i
or 17,07W (typ.)
for 223V5LSB2
| dvale X . Hvid
tandby) | RA | N | Nej | OSW®P) | pipen
Kontakt Fra| FRA - - 05W (typ)) FRA

Folgende opsatning bruges til at méle
skaermens stremforbrug.

* Indbygget oplgsning: 1920 x 1080
*  Kontrast: 50%
*  Lysstyrke: 250 nits or 200 nits

*  Farvetemperatur: 6500k med fuldt, hvidt
mgnster
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6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes

@ environmentally sound recovery
ey and disposal of waste from electrical

and electronic equipment. Toxic

substances like Lead has been eliminated

and compliance with European community's

stringent RoHs directive mandating restrictions

on hazardous substances in electrical and

electronic equipment have been adhered to

in order to make Philips monitors safe to use

throughout its life cycle.

Congratulations!

This product is TCO Certified - for Sustainable
T

TCO Certified is an international
third party sustainability certification

for IT products. TCO Certified.
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited
independent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

* Corporate Social Responsibility
Socially responsible production - working
conditions and labor law in manufacturing
country

» Energy Efficiency
Energy efficiency of product and power
supply. Energy Star compliant, where
applicable

*  Environmental Management System
Manufacturer must be certified according
to either ISO 14001 or EMAS

*  Minimization of Hazardous Substances
Limits on cadmium, mercury, lead
& hexavalent chromium including
requirements for mercury-free products,
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halogenated substances and hazardous
flame retardants

*  Design for Recycling
Coding of plastics for easy recycling. Limit
on the number of different plastics used.

*  Product Lifetime, Product Take Back
Minimum one-year product warranty.
Minimum three-year availability of spare
parts. Product takeback

* Packaging
Limits on hazardous substances in product
packaging. Packaging prepared for recycling

*  Ergonomic, User-centered design
Visual ergonomics in products with a
display. Adjustability for user comfort
(displays, headsets) Acoustic performance
— protection against sound spikes
(headsets) and fan noise (projectors,
computers) Ergonomically designed
keyboard (notebooks)

* Electrical Safety, minimal electro-magnetic
Emissions Third Party Testing
All certified product models have been
tested in an independent, accredited
laboratory.

A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable IT for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around

the world rely on TCO Certified as a tool to
help them reach their sustainable T goals.We
are owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For more information, please visit
www.tcodevelopment.com



Tm

Technology for you and the planet
CERTIFIED

(Only for selective models)

EPEAT

(www.epeat.net)

X The EPEAT (Electronic
QQ Product Environmental
& Assessment Tool) program

evaluates computer

desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

7

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

«  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

«  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

*  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

*  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

«  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2011 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

¢ MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

* TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR”
guidelines for energy efficiency.
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& Note

We recommend you switch off the monitor
when it is not in use for a long time.

4)

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

*  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences


www.energystar.gov

nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre |'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTAVERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
HAZHERERZIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

K RoHS
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EU Energy Label

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year

SNote
The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter
pa fladskaerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udfgrer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skeerme dog uundgaelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pd en TFT
-skaerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skerm vare defekte. Desuden seetter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
gaelder i hele verden.

sub-pixler sub-pixler  sub-pixler

T

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primarfarverne red, gren og
bla. Nar mange pixler szettes sammen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser, fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er marke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og merke sub-pixler fremstdr som
enkelte pixler i andre farver.

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa
skaermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skeermbilledet, nar skaeermen viser et
mearkt menster. Der er fglgende typer defekte
lyse prikker.

En teendt red, gron eller bld sub-pixel.

I C

To sammenliggende tendte sub-pixler:
- Red + Bla = Lilla
- Red + Grgn = Gul

- Grgn + Bla = Cyan (Lysebld)

Tre sammenliggende tendte pixler (en hvid
pixel).
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@ Bemaerk

En red eller bld lys prik skal vaere mere end 50
procent lysere end de omkringliggende prikker,
mens en gran lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte morke prikker

Defekte marke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er“slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstdr pa skaermbilledet,
nar skaermen viser et mgrkt menster. Der er
felgende typer defekte marke prikker

Tatsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for tetsiddende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skaerm i en Philips
fladskaerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
folgende tabeller:

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
1 teendt sub-pixel 3

2 sammenliggende taendte sub-pixler 1

3 Tre sammenliggende taendte sub-pixler (en hvid pixel) 0

Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
1 mark sub-pixel 5 eller ferre

2 sammenliggende marke sub-pixler 2 eller ferre

3 sammenliggende mgrke sub-pixler 0

Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller ferre

@ Bemaerk

1. 1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt

2. Denne monitor er i overensstemmelse med 1SO9241-307 (1ISO9241-307: Testmetoder for
ergonimiske krayv, analyse og overensstemmelse pa elektroniske visuelle skeerme)
3. 1SO9241-307 is de opvolger van de voormalige ISO13406-standaard, die op 13 november 2008

ingetrokken is door de International Organisation for Standardisation (ISO).




7.2 Kundeservice og garanti

For oplysninger om garantidaekning og gzeldende stattekrav i dit omrdde, bedes du besgge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land CSP Hotline nummer Pris Abningstider

Austria RTS +43 0810 000206 €0.07 Mon to Fri:9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri:9am - 6pm
Cyprus Alman 800 92 256 Free of charge | Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff [ Mon to Fri:9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri:9am - 6pm
Germany RTS +49 01803 386 853 | € 0.09 Mon to Fri:9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge [ Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri : 8am - 5pm
Italy Anovo ltaly | +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri:9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff [ Mon to Fri:9am - 6pm
Poland MSI +48 0223491505 Local call tariff [ Mon to Fri:9am - 6pm
Portugal Mainteq 800 780 902 Free of charge | Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €0.10 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri: 9am - 6pm
Switzerland ANOVO CH [ +41 02 2310 2116 Local call tariff | Mon to Fri: 9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri:8am - 5pm

Kontaktoplysninger til Kina:

Land
China

Kundeservice tlf
4008 800 008

Callcenter
PCCW Limited

Kontaktoplysninger tiil NORDAMERIKA:

Land Callcenter Kundeservice tif
USA. EPl-e-center (877) 835-1838
Canada EPl-e-center (800) 479-6696



www.philips.com/support
www.philips.com/support

Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter CSP Kundeservice tlf

+37517 217 3386
Belarus NA IBA +37517 217 3389
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300

+372 6519900(General)
Estonia NA FUJITSU +372 6519972 (workshop)
Georgia NA Esabi +995 322 91 34 71

+36 1 814 8080(General)

+36 1814 8565(For AOC&Philips
Hungary NA Profi Service only)
Kazakhstan NA Classic Service l.l.c. |+7 727 3097515

+371 67460399
Latvia NA ServiceNet LV +371 27260399
Lithuania NA UAB Servicenet ig;g ;7}0%%%186%(5?;%?&)
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
Serbia&Montenegro | NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
the republic of Belarus | NA ServiceBy + 37517 284 0203
Turkey NA Tecpro +90 212 444 4 832
Ukraine NA Topaz +38044 525 64 95
Ukraine NA Comel +380 5627444225

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter
Brazil

: Vermont
Argentina

Kundeservice tif
0800-7254101

0800 3330 856
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Kontaktoplysninger til APMEA:

Land

Australia

ASP
AGOS NETWORK PTY LTD

Kundeservice tlf
1300 360 386

Abningstider
Mon.~Fri. 9:00am-5:30pm

New Zealand

Visual Group Ltd.

0800 657447

Mon.~Fri. 8:30am-5:30pm

Ltd

Hong Kong Company: Smart Pixels Hong Kong; Mon.~Fri. 9:00am-6:00pm
Maca Technology Ltd Tel: +852 2619 9639 Sat. 9:00am-1:00pm
. gy L Macau:Tel: (853)-0800-987 -7am- TP
. Tel: 1 800 425 6396 .
India REDINGTON INDIA LTD SMS: PHILIPS 1o 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086 (Customer N : A
ndonesia | PTFCORMICSERVISINDO | Hotline) :43?86-3?5608'30_1 200
PERKASA +6278888-O1 -9086 (Customer Fri. 08:30-11:30; 13:00-17:30
Hotline)
. Mon.~Fri. 9:00am-5:30pm
Korea Alphascan Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. . Mon.~Fri. 8:15am-5:00pm
Malaysia R-Logic Sdn Bhd +603 5102 3336 Sat. 8:30am-12:30am
Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Philips Electronics Singapore 28 Gr ;
Singapore | Pte Ltd (Philips Consumer Care | (65) 6882 3966 Mon.~Fri. 9:00am-6:00pm
Sat. 9:00am-1:00pm
Center)
Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00
Thailand ﬁfj's Computer System Co. | 4 ¢9y 934.5498 Mon.~Fri. 8:30am~05:30pm
South Africa | Computer Repair Technologies [011 262 3586 Mon.~Fri. 8:00am~05:00pm
Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00
+84 8 38248007 Ho Chi Minh
FPT Service Informatic City 2 ; )
Vietnam Company Ltd. - Ho Chi Minh | +84 5113.562666 Danang City :470;10 522388:1 %88’ 13:30-
City Branch +84 5113.562666 Can tho T '
Province
Phiippines | £/ Global Supply Chain (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions Inc.
Armenia
Azerbaijan
Georgia Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00
Kyrgyzstan
Tajikistan
Uzbekistan | -0k Flus Private Enterprise | 4 99471 578450 Mon.~Fri. 09:00 - 18:00

Turkmenistan

Technostar Service Centre

+(99312) 460733, 460957

Mon.~Fri. 09:00 - 18:00

Japan

T4V T AE=H—
R—hEo & —

0120-060-530

Mon.~Fri. 10:00 - 17:00
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan
klares af brugeren selv. Hvis problemet stadig er
der; efter at du har prevet disse lgsninger, skal
du kontakte Philips' kundeservice.

a Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller, at ledningen er sat i
stikkontakten og bag pa skarmen.

* Kontroller ferst, at stremkontakten foran
pa skaeermen er i OFF (FRA), og stil den
derefter pd ON (TIL).

Intet billede (stremdiode lyser hvid)
*  Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede
stikben pa signalkablets stik. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

*  Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

* Tjek, om skeermkablets stikben er bgjede.

* Kontroller, at der er tendt for computeren.

AUTO (AUTOM.) knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.
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& Bemark
Den automatiske funktion er ikke ngdvendig i
DVI digital-tilstand.

Synlige tegn pa rog eller gnister
*  Forsgg ikke selv at fejlfinde

e Trek straks skeermens stik ud af
stikkontakten

»  Kontakt straks en repreesentant fra Philips
kundeafdeling.

2] Billedproblemer

Billedet er ikke centreret

* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock
(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skarmen
* Tiek at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.



Billedet er slgret, uklart eller for markt
* Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”,
“brandmarkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

*  Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skaermen.
“Breendmaeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt feenomen
i LCD skaermteknologi. | de fleste tilfeelde vil
“brandmaerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skaermen er blevet slukket.

* Serg altid for at aktivere en pauseskeerm,
der bevager sig, nar skeermen efterlades
uden at blive anvendt.

* Du skal altid bruge en pauseskaerm eller
et andet program, der opdaterer skeermen
regelmeessigt, hvis LCD skeaermen viser
statisk materiale i leengere perioder:

* Alvorlig “brandmaerkerne’- eller
“efterbillede”- eller “spagelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvranget. Tekst er utydelig eller

slaret.

* Indstil pc'ens skeermoplasning som
skaermens anbefalede, native opl@sning.

Der ses rgde, bld, merke og hvide pletter pa

skaermen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Teendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Taendt” lyset med
Strgmdiode i OSD-menuerne.

For yderligere hjeelp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.
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8.2 Generelle FAQ

SP1: Hvad skal jeg gore, hvis skermen under

installationen viser “Cannot display

this video mode” (Kan ikke vise denne

videotilstand)?

Sv.. Den anbefalede oplasning pa denne
skaerm: 1920 x 1080 pa 60 Hz.

*  Frakobl alle kabler og forbind derefter

pc'en til skeermen, som du brugte for

* | Windows Startmenuen, valg Settings/
Control Panel (Indstillinger/Kontrolpanel). |
Control Panel (Kontrolpanel)-vinduet veelg
Display (Skaerm)-ikonet. | Egenskaber for
Skeerm-vinduet veelg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet “desktop area" (skrivebordsomrade),
skal du stille justeringsbjeelken pa 1920 x
1080 pixler.

+  Abn “Advanced Properties” (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

* Genstart computeren og gentag trinene
2 og 3 og bekreeft, at pc'en er indstillet til
1920 x 1080 ved 60 Hz.

*  Luk for computeren, frakobl den gamle
skeerm og genforbind Philips LCD skeaermen.

* Tend for skeermen og derefter for pc'en.

SP2: Hvad er den anbefalede
opdateringshastighed pa LCD skarmen?
Sv..  Den anbefalede opdateringshastighed
pa LCD skeerme er 60 Hz. | tilfeelde af
forstyrrelser pa skaermen skal du sztte
den op til 75 Hz og se, om dette fierner
forstyrrelserne.

SP3: Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Sv.:  Dette er skermens driverfiler. Installer
driverne i henhold til brugervejledningen.
Computeren kan bede dig om
skeermdrivere (.inf og .icm filer) eller om
en driverdisk, ndr du installerer skaermen

forste gang. Indsaet (medfelgende cd-rom)



SP4
Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8
Sv.:

i pakken i henhold til vejledningerne.
Skaermdrivere (inf og .icm filer) installeres
automatisk.

: Hvordan justerer jeg oplasningen?

Skaermkortet/grafikdriveren og skaermen
bestemmer sammen oplasningerne til
radighed. Du kan veelge den gnskede
oplesning under “Egenskaber for Skaerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skaermen?

Sa skal du blot trykke pa OK og derefter
vaelge "Reset” (Nulstil) for at ga tilbage il
de oprindelige fabriksindstillinger.

Er LCD-skarmen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udsatte
skaermens overflade for kraftige sted.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sa

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renggr jeg LCD skaermens
overflade?

Til normal renggring skal du blot anvende
en ren, blad klud.Til kraftigere renggring
skal du bruge isopropylalkohol. Brug

ikke andre opl@sningsmidler sasom
ethylalkohol, ethanol, acetone, hexan osv.

: Kan jeg ®ndre skaermens farveindstilling?

Ja, du kan andre farveindstillingen via
OSD pa felgende made:
Tryk pa “OK" for at vise OSD (On Screen
Display) menuen
Tryk pa “Down Arrow” (Ned-pil) for
at veelge indstillingen “Color” (Farve),
og tryk derefter pa “"OK" for at angive
farveindstillingen. Der er tre indstillingen,
som vist nedenfor.

1. Farvetemperatur med to indstillinger;
6500K og 9300K. Med indstillinger i
6500K omradet virker skermen “varm,
med en rgd-hvid farvetone”, mens en
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9300K temperatur giver en “kold bla-
hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer, skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan velge sin foretrukne
farveindstilling ved at indstille den rede,
grenne og bla farve.

& Bemark

En malning af farven pa lys, der udstrdles fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rede,
hgjere temperaturer sasom 9300K er bla.
Neutral temperatur;, 6504K, er hvid.

SP9: Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
vaere ngdvendig for at kunne forbinde
skaermen til dit Mac-system.Vi anbefaler;
at du kontakter Philips salgsrepraesentant
for yderligere oplysninger:

SP10: Er Philips LCD skarme “Plug & Play”?

Sv.:  Ja, skeermene er “Plug & Play” kompatible
med Windows 7/Windows 8/Vista/XP/
NT, Mac OSX og Linux

SP11: Hvad er “billedklebning” eller
“billedindbranding” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skaermen.
“Breendmeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
fenomen i LCD skermteknologi. | de
fleste tilfeelde vil “brandmeerkerne” eller
“efterbilledet” eller “spggelsesbilledet”

Sv.:

Sv.:



forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskarm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskaerm

eller et andet program, der opdaterer
skaermen regelmaessigt, hvis LCD
skeermen viser statisk materiale i leengere
perioder.

O Advarsel

Hvis der ikke aktiveres en pauseskaerm eller
et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbreendinger” eller
“efterladte billeder” eller "spggelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstdende skade deekkes ikke af
garantien.

SP12: Hvorfor viser skermen ikke skarp tekst?
Hvorfor viser den forrevne tegn?

Sv..  Din LCD monitor virker bedst pa dens
native oplasning pa 1920 x 1080 ved
60 Hz. Brug denne oplasning for at opna
det bedste billede.

35



PHILIPS

© 2013 Koninklijke Philips N.V.Alle rettigheder forbeholdes.

Philips og Philips Shield Emblem er registrerede varemarker tilhgrende
Koninklijke Philips N.V.,, og bruges under licens fra

Koninklijke Philips N.V.

Specifikationerne kan andres uden varsel.

Version: M5223V1T



	1.	Vigtigt
	1.1	Sikkerhedsforanstaltninger og vedligeholdelse
	1.2	Notationsbeskrivelser
	1.3	Bortskaffelse af produkt og emballage

	2.	Opsætning af skærm
	2.1	Installation
	2.2	Brug af skærm
	2.3	Fjern standeren og foden

	3.	Billedoptimering
	3.1	SmartContrast
	3.2	Philips SmartControl Lite

	4.	Tekniske specifikationer
	4.1	Opløsning og forudindstillede funktioner

	5.	Strømstyring
	6.	Lovmæssige oplysninger
	7.	Kundeservice og garanti
	7.1	Philips' regler ved pixeldefekter på fladskærme
	7.2	Kundeservice og garanti

	8.	Fejlfinding og FAQ
	8.1	Fejlfinding
	8.2	Generelle FAQ


